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Before You Begin

The Ingtallation Guide will help you do three things:

= Makeimportant decisions about implementing TapeWare before installing
TapeWare.

= Install TapeWare.
= Understand the basics of how to work with TapeWare.

If you areinstalling TapeWare on aLAN, be certain to read Section 2 for
important information before ingtalling TapeWare.

TapeWare Documentation

On the Ingtallation CD-ROM, you will find the file Twusersguide.pdf along with
the Adobe Acrobat Reader 3.0. Thisfile contains the User’s Guide and Technical
Reference. This manual contains helpful discussions of TapeWare concepts,
detailed step-by-step instructions, hel pful tips, and a complete reference section to
permissions (security) and object properties.

Although the contents of this manual are aso availablein the on-line help file, we
recommend you print this manual. It was designed to be printed one-sided, with a
margin for placing it in abinder.

To print the documentation, open the Twusersguide.pdf file with the Adobe
Acrobat Reader. Choose Page Setup... from the File menu and set the proper
options for your printer. Be certain to select the Larger Print Area option if your
printer supports this option. Then choose Print... from the File menu and print
the document.

(You can aso purchase additiona printed and bound copies of this manual.
Contact us at the numbers listed below for additional information.)

Additionally, you will find a PDF file named ErrorCodes.pdf. This document,
approximately 42 pages long, contains a complete listing of all the TapeWare error
codes. Y ou can use the Adobe Acrobat Reader to print thisfile.
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On-line Help

To get on-line help while using TapeWare, select Help Topics from the Help
menu.

For context-sensitive help while using TapeWare, either

= click onthe Help button and then click on the part of the object you want help
with, or

= click on an object with the right mouse button and select What'sthis?, or
= usethe Tab key to “target” an areain the TapeWare window and press F1.

Customer Support
Y ou can get customer support for TapeWare in one of four ways:

= Visit our web-site at www.tapeware.com. (For a quick connection, select Web
Page from the Help menu.)

= Email usat support@tapeware.com.
= Fax usat 209.292.8908

= Phone us at 209.292.8888. Our customer support hours are 8 am. to 5 p.m.,
Pacific time, Monday through Friday.






SECTION 1

Overview of TapeWare Concepts

TapeWare provides a powerful, yet cost effective and easy to use, management
tool for protecting data on network file servers and workstations. TapeWare
provides users with the capacity to back up and restore data across a network and
the ability to administer acomprehensive backup plan.

A complete network backup system consists of three parts: the physical
peripherals, the database, and the backup management program.

Physical Peripherals

For further
information about
backup device LAN
location, see “Setting
up a TapeWare
Network,” Section 2.

TapeWare works with your existing computer network. A network connects
workstations and file servers together in order to allow various users to work
together on projects and with common files. Networks also allow usersto share
peripherals, such as disk drives, printers, fax machines, and modems. Sharing
peripherals across a network makes economic sense, since multiple workstations
can use asingle peripheral. Backup devices, such as tape drives, which backup or
copy files onto tapes or other media, may also be shared.

Sharing a backup device or tape drive makes operational aswell as economic
sense. Rather than back up each workstation individually, a shared backup device
on anetwork can back up every workstation and file server on the network. This
lowers costs and makes it possible to centralize backup operations for the network.
Further, asingle user, such as the network administrator, can have primary
responsibility for backing up all the file servers and workstations on a network.
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Although sharing a backup device or tape drive on a network makes economic and
practical sense, it also poses several problems.

First, security isan issue. Most networks have elaborate security systems that
prevent sensitive or confidential data from being accessed by unauthorized
users. However, unless protective measures are taken, once these files are
backed up onto atape or other media, any user in physical possession of the
media can gain access to those files. Although it is possible to physically store
the mediain a secure location, a complete network backup system will prevent
unauthorized viewers from accessing confidential or classified information.

Second, tracking the location of backed up filesis afurther issue. While a
single user may be able to find afile backed up onto afloppy disk by
manually searching through a stack of disks, this approach is unworkable for
large networks. Without the appropriate software, locating a given occurrence
of afile may be impossible, since there may be hundreds of thousands of files
backed up on hundreds of tapes created over weeks or months.

The Database

To solve the problems of security and tracking files, TapeWare creates and
manages a database. The TapeWare database keeps track of each tape or other
media and each file that is on that tape. For each tape, the database contains detailed
information about the tape, such as when it was created and who created it, and
about the files on the tapes, such as when they were backed up and on which tape
thefileis stored. Thisistrue as well for other media.

For further
information on
working with the
database, see
“Setting up a
TapeWare Network,”
Section 2.
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The database a so addresses the security complication. Included in the databaseis
information about which users can use or view which files. The database prevents
unauthorized users from accessing files for which they have no security clearance.
The database tracks each user and ensures that only approved users have accessto
files stored on the backup media.
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The Backup Management Program

Writing files to the backup media and managing the database requires an
application program, such as TapeWare. Two of the most important functions of
TapeWare are managing the database and creating and running jobs. TapeWare
manages the database to keep track of files and to ensure security. TapeWare also
creates and runs jobs, such as backup and restore jobs which transfer files back
and forth between backup devices (such as tape drives) and file servers and
workstations.

Managing the Database

Much of the power and usefulness of TapeWare comes from its extensive
capabilities to manage the database. There are three important concepts associated
with the database: objects, properties, and zones.

Objects

The database collects and organizes information about objects. An object isany
file, machine, tape, or user about which TapeWare needs to store data. Examples
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For further

of objects which TapeWare tracksin its database include tapes, tape drives,
network servers, occurrences of files, backup jobs, users, and so forth.

Objects that contain other objects within them are referred to as containers. A
simple example of a container isafolder. It contains other objects within it,
including objects that are not containers, such as jobs and files, and objects that are
containers, such as other folders.
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Properties

The information about each object that TapeWare storesin its database are called

information on properties. The properties of each object include important information about that
property sheets, see  object, such aswhat kind of object it is, who has security clearance to useit, and its
Chapter 12 of the relationship to other objects.

User's Guide and

Technical Reference.

For example, an individual backup tape is an object in the TapeWare database.
Some of the properties of that tape stored in the database include the name of the
tape, when it was created, who has clearance to use the tape, and whether or not the
tape can be erased.
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Working with TapeWare objects and propertiesis easy. Even though when you
work with TapeWare you work primarily with objects and properties, extensive
knowledge about objects and propertiesis not necessary. If you know how to use
Windowss Explorer™, you already know most of what you need to use
TapeWare. If you need additional information, consult Section 4 of this manual or
Chapter 2 of the TapeWare User’s Guide and Technical Reference.

Zones

TapeWare is not limited to just one database. On alarge network, it may be useful
to have multiple databases, each addressing different storage needs. For example,
there may be a separate database for each work group or department, even though
they are al on the same network.

If your network has multiple TapeWare databases, then you choose which
database you wish to use by selecting a database zone when you log on to
TapeWare. Choosing a database zone is smply away to select which database you
wish to use.

Each TapeWare database zone is overseen by a TapeWare administrator . Itis
the TapeWare administrator’ s job to manage the security and integrity of the files
in hisor her database zone.
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For further
information, see
Chapter 11 of the
User’s Guide and
Technical Reference.

Database Zones and Security Database zones also help insure network security.
TapeWare uses database zones to promote security in two ways. first, by
preventing users from working with more than one database zone at atime and,
second, by alowing file servers and workstations to be the member of only one
database zone.

Note the following about machines, users, and database zones:

= Workstations or file servers (called a machine container) can only be the
member of one—and only one—database zone. Because these machines
belong to only one database, their peripherals, such as disk drives and backup
devices, can belong to only one database.

= Tapesor other mediacreated in one database zone cannot be used in another
database zone without following special procedures. Thisinsuresthat thereis
no improper access to secure files and data.

= Each database zone must have at least one backup device, such as atape drive.
Further, that backup device can only belong to one database zone: it cannot be
shared among multiple zones. (However, a database zone could have multiple
backup devices.)

= From one workstation, a user can work in other database zones besides the
zone his or her workstation belongs to. This means they can remotely
administer jobs for other database zones besides the zone their workstation
belongs to. They cannot, however, work in multiple database zones at the
sametime.

= A user can work from their home machine with other database zones besides
the one to which their machine belongs. Their machine, along with its drives,
peripherals, and accompanying data, however, dwaysremain in asingle
database zone. This helps to prevent the unauthorized sharing of data between
database zones. Thus while users can work outside of their database, the
workstations and file servers they use aways stay within their home zone.

Creating and Running Jobs

TapeWare creates backup tapes and restores files with jobs. Working with backup
devices and the LAN, TapeWare jobs either back up network file servers and
workstations onto media or restore files from media onto file servers or
workstations. When you want TapeWare to backup or restore afile, you create and
run ajob.

There are severd kinds of jobs, including backup, restore, and verify jobs. Every
kind of job you create and run has six components: creating the job, permissions,
selection, options, scheduling, and running.
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Creating the Job Y ou begin by creating ajob, either a backup, verify, or restore
job.

Permissions In order to create ajob, you must have permissions to the objects
that job will work with. For example, to create a backup job, you must have
permissions to the tape drive, the tape, and the files you will backup. If you wish
to backup files on another workstation, you must have permissions to that
workstation and to the files on that workstation. Individual users are assigned
permissions by the TapeWare administrator, who is responsible for ensuring the
security and integrity of the backup system.

Selection Once you have permissionsto afile, you must select it to beincluded in
your job. You might select all files, only afew files, or perhaps only asinglefile.
Y ou select filesfirst by selecting them in the selection window and second by
having TapeWare ‘sort’ them with filters, which apply additional selection criteria
such as date modified, type of file, and so forth.

Scheduling After selecting files, the job is scheduled to be run. A job may be
scheduled to run later or to run immediately. It can be scheduled to run regularly or
only once.

Options After scheduling the job, you specify the job’ s option parameters. Some
of the options you can specify include what backup device to use, what mediato
use, whether to automatically format the media, and so forth.

Running Finaly the job isrun. Many scheduled jobs are run automatically by
TapeWare, but you can manually run ajob at any time.

Every time you create ajob in TapeWare, your job must include these six
components. Y ou begin by specifying atype of job. Before you can proceed
further however, you must be certain that you have permissionsto the objects,
such as files and tape drives, that you wish to use. Y our TapeWare administrator
will work with you to determine which type of permissions you require. Then you
sdect thefilesfor your job, specify the option parameters, and finally schedule the
jobtorun.

These six components of creating and running jobs are covered in detail in
chapters 3 through 8 of the User’s Guide and Technical Reference.



SECTION 2

Setting up a TapeWare Network

This section contains information you should review beforeinstalling TapeWare.
It can help you make some important decisions about how to implement
TapeWare which will help you work more efficiently with TapeWare. In
particular, this section discusses where on your LAN to locate the database and
backup devices. If you make these decisions before you install TapeWare, your
work will be more productive.

Managing the Database

An important decision when planning a comprehensive backup strategy is where
to locate the TapeWare database. This part explores some considerations you
should review before making this decision.

Deciding Where to Locate the Database

» Consider locating the database on a workstation or file server other than the
main file server.

Recall that TapeWare keeps track of objects and properties in a database that it
creates and manages. Where should you store this database? That is, on what
volume and machine should the database be stored?

TapeWare lets you locate the database on any machine (workstation or file server)
or volume in the database zone. Note that the database does not have to be on the
same machine as the backup device. It could be placed on any volume of any
machine that is amember of the database zone.



Section 2

Setting up a TapeWare Network 13

You can locate the
database on any
machine in the
TapeWare network,
including, in this case,
a workstation. Attach
the backup devices to
machines using local
buses for greatest
speed.

You can administer a
job from a different
database zone.
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For example, suppose you have afile server with alarge RAID device attached.
Backup jobs using this RAID device will run fastest when the backup deviceis
placed on the same machine as the RAID device. On the other hand, the database
may be best located on another machine other than the file server. Thisis because
if the file server were to become inoperable (for example, the drive were to crash),
you would still be able to use the database to restore the file server volumes. Had
the database had been located on the file server, however, the database must first
be restored before other files could be restored. This can be alengthy, time-
consuming process.

A good strategy to consider is to place the backup device on the file server for
maximum speed, but to locate the database on a separate machine. Consider this
example. Two file servers are connected on an Ethernet network. Each file server
has its own backup device, which helpsthe jobs run faster and more efficiently.
The database for al three machinesis located on a separate machine (which can be
called a*“ database server”). Jobs can be run from this database server; additiondly,
they can also be run from any other machine on the LAN as well.

TapeWare Zone
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(Note that the backup device could just as easily been placed on any other machine
in the network. TapeWare does not require that the backup device be physically
attached to afile server. Additionally, while the term “ database server” isa
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For further
information on
restoring a corrupted
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Chapter 9 of the
User's Guide and
Technical Reference.

convenient label, in fact, TapeWare does not require that this machine be a network
server. It could just aswell be a client machine or workstation.)

This arrangement has several features to recommend it. First, jobs run quickly
because most of the datais transferred over local buses, instead of over the
network. In this arrangement, TapeWare will automatically route data from each of
thefile servers over local busesto its own backup device. Whenever thereisa
choice, TapeWare automatically routes data over local connections rather than
network connections.

Second, administering jobsis uncomplicated. Jobs can be created and run from
any machine on the network. Note that jobs can also be administered from a
machine that is amember of adifferent database zone. The TapeWare
administrator or other user can log on to this database from another database zone
and then create and run jobs in that zone.

Third, suppose a disaster occurs and the RAID device of one of the file servers
needs to be replaced. Because the database is located on another machine, recovery
isquick and easy. The database contains all of the information necessary to restore
the lost data. Had the database been stored on the file server, recovery would have
been much more difficult. Note that the backup device on the other file server can
be used to help restore the file server that failed.

Fourth, suppose the database server fails and the TapeWare database is lost. While
the loss of the database server is significant, the file servers are not impacted and
they can continue to perform their tasks. Backups can still be run from another
machine on the network, or if need be, from the file servers themselves. Since the
database was lost, it will have to be imported from existing tapes. This step,
however, is not crucial and can be run when convenient, as long as careful backup
procedures are followed (that is, no important tapes are overwritten and afull
backup job is run immediately).

The advantages of this arrangement extend to any backup strategy or network
arrangement. In general, consider placing the TapeWare database on amachine
separate from the most important data. At the very least, consider locating the
database on a separate volume.

Accounting for Database Size

Before deciding where to locate the database, consider how large the TapeWare
database might eventually become.

The size of the database is primarily afunction of the number of tapesin the
backup set, the number of files backed up, and the number of instances of each file
on valid media. To alesser extent, the number of objects in a database and the
properties of those objects affect the size of the database.
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In its database, TapeWare assigns

» 40 bytesfor each instance of afile,

» 128 hytesfor each database object, and

» 1024 bytesfor the properties associated with objects.

Y ou can use these figures to estimate the size of the database. Files are by far the
most numerous of the objects in the database, so much so that the size of the other
objects (such as users and jobs) is negligible. Each file that is backed up is made
part of the database and is assigned 128 bytes. While this figure can be significant,
the number of instances for that file in the database are more important when
predicting the size of the database. Thisis because there might be as many as 20 or
30 instances of a particular filein the database. (Files only have properties
associated with them when they are assigned permissions or storage streams, but
generaly, since most filesinherit their permissions from other objects, the 1024
bytes assigned for properties can be ignored.)

Consider the following example. Suppose afile server which holds 100,000 files
isregularly backed up using the GFS-25 automatic rotation schedule. Because
there are 25 tapes in this backup set, there are potentially 25 instances of each of
these files (although in practice, there will be fewer instances since most of the
jobs areincremental). Y ou can predict the size of the database as follows:

[(# of files) * (128 bytes)] + [(# of instances) * (# of files) * (40 bytes)] ; or
[(100,000) * (128 bytes)] + [(25) * (100,000) * (40 bytes)] = ~108 MB.

Database Location and Machine Platforms

Finally, consider the operating system of the machine on which the databaseis
located. For multi-user, LAN installations, place the database on either a Windows
NT server or a NetWare server. While the database can be located on amachine
running Windows 95, this option is not recommended. Performance on network
installations will be increased when using an NT or NetWare server.

For single machine installations, TapeWare a so runs on Windows 95 and DOS
platforms, although TapeWare runs more efficiently with Windows 95 than with
DOS.

Locating Backup Devices and Optimizing Job Speed

TapeWare is designed to run jobs quickly and efficiently on various network
platforms and arrangements. However, you can increase the speed of jobs by
placing backup devices in optimal positions. This part will help you plan your
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backup strategy and network installation to maximize TapeWare' s speed and
efficiency.

What Slows Down Tape Drives?

Tape drives work most efficiently when they are “ streaming,” that is, when the
tape itself is constantly moving forward and a steady flow of datais being written
to the tape asiit passes the write head. In general, tape drives will “stream” if there
isaconstant flow of data available to write to the tape.

Whenever there is an interruption in the data and the drive must wait for the data,
the “stream” breaks off and the tape stops. Additionally, after the tape stops, the
drive must reposition the write head and regain the vel ocity of the tape. To do so,
the drive will back up the tape prior to where it stopped writing, and then restart the
tape forward again. This can be atime consuming process, especialy if it occurs

repeatedly.

For thisreason, it isimportant to keep data constantly flowing to the tape drive.
The performance of your job will be maximized when the tape drive constantly
has data availabletoit.

Maintaining the Flow of Data

There are several steps you can take to make sure that dataiis constantly available
to the backup device.

Prefer Local Busses to Network Connections In general, data is transmitted more
efficiently over alocal busthan over a network connection. Thus, for example,
performance will increase if the backup device is placed on the network file server,
rather than on a client machine, although either arrangement is possible.

Note that the database need not be placed on the same machine as the backup
device. The location of the database does not effect the rate of data transmission.
(Other features of the jobs, such as building backup selection lists and opening and
closing files, create network traffic and require CPU calculations. While the
location of the database will effect these parts of the job, the advantages of a
remote location of the database often outweigh any speed |0ss.)

Add a Second Device Controller Even though a backup device and volume may
be on the same machine with alocal connection between them, if the backup
device and the volume share the same device controller, this limits the speed of
data transmission. Adding a second device controller can effectively double the
rate of datatransmission. For example, consider adding a second SCS| controller
for the exclusive use of the backup device. This can result in adramatic
improvement in the rate of data transmission.
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Use a Wider Data Stream For both network and local connections, the width of
the data stream effects the rate at which data can be transferred. Many tape drives
are capable of writing data much faster than can be transferred over older device
controllers and network connections. By upgrading to more recent technology with
wider data streams, there will be fewer interruptions in the stream of datato the
backup device. For example, consider using a Wide or UltraWide SCSI controller
for the backup device. Additionally, for network connections, consider upgrading
from 10Base-T Ethernet to 100Base-TX.

Consult your manufacturer’ s documentation to seeif your backup device would
benefit from awider data stream.

Increase CPU Speed In genera, afaster CPU resultsin faster backups. Take the
speed of the CPU into account when deciding where to place the backup device
and to locate the database.

Additional information

For additional information about how to run jobs faster, consult Chapter 10 of the
User’'s Guide and Technical Reference.



SECTION 3

Installation Guide

Installing TapeWare is simple and easy. The Install program automatically
configures TapeWare to work on your machine with your network software and
will prompt you when you need to specify installation parameters.

Before you install TapeWare, be certain you know the following:

= the name of database zone you wish to create.

= the machine on which you will locate the database.

= which workstations or file serverswill belong to the database zone.

= the Key Code for the product and configuration you have purchased.

If you are uncertain about creating a database zone and assigning machinesto a
database zone, see Sections 1 and 2 of this manual for more information. The
following part discusses product configuration.

Product Configuration

When fully implemented, TapeWare can work with any network configuration of
Windows NT, Windows 95, NetWare, and DOS machines, with no limitation on
the number of machines, servers, or backup devices.

However, what product you have purchased may limit your installation choices.
The number of serversin a database zone and the network platform TapeWare
runs on depend on which product you purchased. Y ou can purchase license
agreements for a single machine, asingle server, or an unlimited number of
servers. Similarly, your license agreement determines whether TapeWare will run
only on aWindows NT network, on a NetWare network, or on both (including
“mixed” networks).

If you have purchased a single server license agreement, you can have one
NetWare or Windows NT file server in that zone. If you want to have multiple
serversin asingle database zone, you can purchase an upgrade to your license
agreement.
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If you have purchased alicense agreement to install TapeWare on only one
network platform, the Install program will only install TapeWare on the specified
network platform. If you want to install TapeWare on another network platform,
you can purchase an upgrade to your license agreement.

If you want to create more than one database, you must purchase an additional
software license. Each product purchased creates one and only one database zone.

Installation and Database Zones

Y ou should install TapeWare on the workstation or file server where the database
isgoing to be located first. When you do so, you create a database zone and
specify the folder (the directory) in which the database will be stored. TapeWare
needs thisinformation when configuring other machines that belong to this
database zone.

After first installing TapeWare on the machine where the database is going to be
located, later, when you install TapeWare on other workstations or file servers,
TapeWare looks to see what database zone is available on the LAN. As part of the
installation procedure, you will be prompted to confirm that you want this machine
to be part of the database zone you have already created.

Installation Instructions

(The following instructions assume that your CD-ROM drive has been assigned
thedriveletter D:. If thisisincorrect, substitute the proper drive letter.)

DOS

Change the drive to the CD-ROM drive and then type INSTALL . Consider this
example.

C.> D: [ENTER|
D: > | NSTALL [ ENTER]

NetWare

If you have a CD-ROM drive attached to the file server, mount the CD-ROM
drive and type LOAD TAPEWARE:INSTALL. Consider this example.

SERVER: CD MOUNT cd-rom devi ce [ ENTER]
SERVER: LOAD TAPEWARE: | NSTALL [ ENTER]
If you do not have a CD-ROM drive attached to the file server, you must create an

install directory and copy theinstall program to that directory. Consider this
example.
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From a workstation:

C.> MD F:\TWNS [ ENTER]

C. > MD F:\ TW NS\ NET [ ENTER]

C. > COPY D:\ | NSTALL. NLM F: TW NS [ ENTER]
C.> COPY DI\NET\*.* F:\ TW NS\ NET [ ENTER]

Then fromthe server:

SERVER: LOAD SYS: TW NS\ | NSTALL [ ENTER]

Windows (95 or NT)

If you are running Windows 95 or Windows NT 4.00, insert the CD in your CD-
ROM drive. Setup.exe will automatically be run. (If thisfails to work, double click
the Setup.exefile on the CD).

If you are running Windows NT 3.51, change the drive to the CD-ROM drive and
then type SETUP. Consider this example.

C.> D [ENTER|
D: > SETUP [ ENTER]

Installing TapeWare as a Service

When TapeWare isinstalled and run as a service, it will automatically be run
whenever the systems starts up. When it runs asa service, it will runin the
background without the user interface, athough you can make TapeWare' s user
interface active a any time by double-clicking on the TapeWare icon. Later, when
you close TapeWare, it returns to service mode and runs in the background again.

Installing TapeWare as a service can be very useful because TapeWare will run
backup jobs automatically and unattended. This can be essential after a power loss,
for example. If TapeWare isinstalled as a service and there is a power loss, after
power returns, TapeWare is automatically run in the background when the system
restarts, insuring that any scheduled jobs are run.

When you install TapeWare on a Windows 95 or Windows NT machine, the
install program will ask you if you want to ingtall it asa service. Toinstall it asa
service, check the appropriate check box in the Ingtall program’s TapeWare
Service window.

Note TapeWareis available as a service only on Windows 95 and Windows NT
platforms.
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The TapeWare Workplace

TapeWareis designed to be easy to use. In fact, you may already know how to use
many of its features. This section will familiarize you with the basics of what you
need to know to get strarted using TapeWare. For additional information on
working with TapeWare, see Chapter 2 of the User’s Guide and Technical
Reference.

Starting TapeWare

After you haveingtalled TapeWare, you start it like any other program.

Windows (95 or NT) To start TapeWare in Windowss 95 or Windows NT", click
on the Start button on the Taskbar and select TapeWare from the Program
submenu. Y ou can also create a shortcut to TapeWare and put it on the desktop.
Alternatively, you can double click the Twwinadm.exefilein the Windows
Explorer window.

-~
=

On Windows 95 and o]
Windows NT platforms, TapeWare
start TapeWare by _ Accessaiies
dOUble-CliCking the Explorer Microsaft Reference

G Wew Office Document FioboHELP o5

shortcut on the desktop... - _
= Open Office Document Startlp

* v v ¥

L4 @ Releaze MNote

% Frograms

»
% Documents L4 &t Tapeware £.00
Seftings 3 E-E Tape'w are Administration
... or Selecting @ Find 3 @ Tapeiware Help

TapeWare from the & Heh
Program submenu =T Eun..
on the Start menu. &P Shut Down.

@ Tape'w are |

NetWare To start TapeWare on aNetWaree platform, run TWADMIN.NCF from
SYS.SYSTEM. It is not necessary to specify a search path. Consider the
following example:
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SERVER TWADM N

DOS To start TapeWare on a machine running DOS, position to the directory
where you installed TapeWare. Then type TWADMIN. Consider the following
example:

C. \ TW600>TWADM N

The Logon Window

Each time you start TapeWare, you are shown the TapeWar e L ogon window.

&, TapeWare Logon

-~

E? Enter your uzer name and password to log on to Tapeare,

Databaze zone: ISouth Sequoia Zone j

Uszer name: IGALEN CLARE

Password: I
The TapeWare
Logon window 06141937 12:27 Pm 0K I Cancel I

To log on, you must select a database zone, enter your user name, and enter your
password.

Logging on the First Time

The default user name for the TapeWare administrator is ADMIN. Thereisno
default password required for this user to log on.

Warning TapeWare administrators have unlimited accessto all of the objectsin the
database. Any user who logs on as the TapeWare administrator will have complete
accessto all of the files and machines on the database.

Y our first security step should be to change the TapeWare administrator’s
password. Change your password on the Security tab. Select your User object
and sdect Change Password... from either the Security menu or the Shortcut
menu. Before continuing with the rest of this section, be certain that you have
changed your password

Selecting a Database Zone

When you installed TapeWare, each workstation was assigned to a database zone.
Each workstation or file server, along with its drives and peripheras, can only be
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the member of one database zone. The name of this zone is the default name that
appears in the Database Zone list box.

Normally, you should leave the default name in the list box unchanged. Thisis
because you will typically want to work with the database zone your workstation
belongs to.

Occasionally, however, you may wish to work in adifferent zone. Y ou might be
asked by a coworker or your TapeWare administrator, for example, torun a
TapeWare job in adifferent database zone.

To select adatabase zone other than the default zone, first click the arrow next to
the database zone list box. You will see alist of possible database zones. Select the
database zone you wish to use.

‘ﬁ" TapeWare Logon M= B

-~

E? Enter pour uger name and password to log on to Tape\ware.

Databaze zone: ISouth Sequoia Zone E

To selecta database
zone, click on the
Database zone list box
and selectthe database
you wish to use.

Walley Administration Zone
El Portal Headquarters

Pazaword:

I
06/27/1937 04:34 Prn Ok I Cancel |

Note Although you can log on to different databases, you can only create and run
jobswithin a single database zone. This means, for example, that you will be
unable to restore files backed up from workstations in one database zone to
workstations in another database zone. (If you need to share data from one
database zone to different database zone, see “Import Media’ in Chapter 9in the
TapeWare User’s Guide and Technical Reference.)

User Name and Password

After selecting a database zone, type in your user name and password. If you type
your name or password wrong, you will be asked to reenter your name and
password.

Changing Your Password

Itisagood ideato regularly change your password, particularly if you are working
with sensitive and important data. To change your password, make the Security
tab active by clicking on it. Then choose Change Password... from the Security
menu or the Shortcut menu. Change your password in the User Password
window.
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To change your password, highlight
your User Object icon, and then
select Change Password... from the

For further
information, see
“Running
Scheduled Jobs,”
Chapter 8 of the
User’s Guide and
Technical
Reference.

File  Edit i Wiew  Window

Security menu % T
Mew password: I ******
In the User Password Confim passward: [
window, type in your old
()8 I C |
password and then your L
new password.
Logging Out

On occasions you may want to change the database zone you are using or want to
log on as adifferent user. Although you could quit TapeWare and restart the
program, it is quicker and faster to log on again without quitting TapeWare.

To log on again, choose L og Out from the File menu. Y ou will be presented with
the TapeWare L ogon window and asked to log on again.

J(=W Edit Job Tools Wiew

Mew Object... Ins
Imstanees.. il
Frint Setup...
SelectLog Outfrom the File Bt e kP
menu to log on to a new Prgferences...
zone or to close the main \E@emes Bl+Enter
TapeWare window. BT
Exit Alt+F4 |

Logging Out and Running Scheduled Jobs

TapeWare can run scheduled jobs even when no one islogged on. (Only
scheduled jobs can be performed when no oneis logged on to TapeWare.)

When you leave your workstation, you may need to leave TapeWare open. In
order to not let any other users have unauthorized accessto the LAN, log out of
TapeWare before leaving your workstation. Any scheduled jobs will still run, but
no unauthorized users will be able to work with TapeWare unless they can log on.

The Main TapeWare Object Window

Y ou use the main TapeWare object window to view, create, and manipulate
TapeWare objects, such as jobs and tapes.
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In addition to the menu bar, the TapeWare window has the following parts: tabs,
toolbar, the hierarchical or “treg’ view area, the object detail area, and the status

bar.

&t Yosemite Technoiogies TapeWware

Toolbar ——|S3drin Folder

IS[=] E3

Hierarchical
“ree view" area

Statusbar —

File Edit Job Toolz Wiew Window Help TabS
=3 Backup |@ Hestorel = Verifyl % Medial @ Devicel @ Queuel % Securityl Databasel
2 i e = N A B
=
BE @ &
[ Historical Backups Special Annual NT ta
(23 Legal Docs Archive Report Job MNefiware . .
(2 MT to Metware Transfers Tranzfers 0 b]ect detail
Conservationists Folder g — area
Everyone Folder i
(23 Job Templates GFS-20 Main
; (2 Galen Clark Folder Backup Job
— ----- (23 Sequoia Study Group Folder
w2 Stephen Mather Folder
For Help, press F1 ~ |ADMINGS outh Sequeia Zone |06/14/1997 02:43 P @ Alert I v

Tabs

At the top of the window are eight tabs which help to group and organize similar
sets of objects. For example, you use the Backup tab to display and work with
backup jobs, the Restor e tab to display and work with restore jobs, and so forth.
To display adifferent tab, click on the tab you wish to view. Y ou can also display
adifferent tab by using the View menu.

Toolbar

The Toolbar hasalist box and severa buttons. Not all buttons are on all tabs and
some buttons on atab may be unavailable. When a button is grayed out, it is not
available because no object that it can work with is currently selected.

Up one Level button Properties button

3 o IS ) el ol el |

Listbox ; Display buttons

Y ou can use the View menu to either hide or show the Toolbar .

| £3 dmin Folder

™~
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The Object View Areas

The left side of the window displays containers, such as folders. Examples of
other container objects include networks, workstations, and drives. These are
displayed in hierarchical or “tree” view. This portion of the window is referred to
asthe treeview area.

Theright side of the window isreferred to as the object detail area. It displaysthe
contents of the container currently selected in the tree view area. If you select an
object in the tree view area, you will seeits contents displayed in the object detail
area on the right side of the window.

=y Backupl =) Hestorel =] \.-"enfyl % Medlal @ Dewcel @ Queuel % Secunty

IaAdmln Fuolder i |%|%| @llﬁlﬁl
=2 D South Sequoia Zone 155 | Histarical Backups
- (] Legal Docs Archive
= 20° [CIINT to Netwiare Transfers
(1 Historical Backup3 (£ GF5-20 Main Backup Job - Fiatation Media
g heTga' zDC\LA'ChT'VB f 5FS-20 Main Backup Job Contents of
------ to Mebw'are Transfers : .
O n Iy . () GFS5-20 Main Backup Job -F Special Annual Report Job contain eI:
Containers ----- (2 Cormervationists Folder Selected in tree
. =8 [:l Everyone Folder view area
are displayed _ {10 Job Templates
on the left P |~ [ Galen Clark Folder —
A ~ftha 0 (23 Sequoia Study Group Foldsr :
.Slde ofthe [ (23 Stephen Mather Folder o are qlspla.yed
window, the =85 Metwork in the right side
tree view - EMED El Capitan Server _ILI L ofthe window,
area. | Il | : the object detail
area.

Shortcut Menus

In most windows, when you click the right mouse button, the Shortcut menu
appears. The shortcut menu list commands that pertain to the particular portion of
the screen you clicked on. Thisis often the fastest and easiest way to create new
objects and modify existing objects.
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| @ Devic:el @ Queuel % Securityl Databasel

e e = [ v
R I I o
| LegelDocs  NTto  GFS-20Main Click the right
; Archive Metware Backup.Job mouse button to
Transfers .
bring up a
context-sensitive
Special Annual
Report Job shortcut menu.
View 3
Amrange lcons 3
Froperties

Property Sheets

Every object in the TapeWare database has a property sheet associated with it.
Each property sheet has two or more tabbed pages on it that display the properties
of that object.

Opening Property Sheets

You can display the property sheet of an object in one of three ways.
The Properties = Select the object with the mouse or keyboard, and then click the Properties
button. button on the Toolbar .

= Click the right mouse button on the object to display a shortcut menu, then
sdlect Properties.

= Double-click an object to display its properties. (This shortcut only works with
objectsthat are not containers, such asjobs or files, in the object detail area.)
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You can view the properties of LX"' I 2 . | EEEE' %l *?l

an objecteither by selecting it

and clicking the properties
button on the toolbar...

by double-clicki MHew Media

...or ounle-clickin .

%/he objecticon..g Mew Media Folder
Wiew k

...or selecting
Arrange lcong k

Properties from
the shortcut menu. N

Note Property sheets work just like other windows, except that their size cannot be
changed. Y ou can leave them open when you return to working in the main
TapeWare object window and you can have multiple property sheets open at once.
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